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Introduction 
In part one of Dashboarding Word, “The Ribbon Untied”, you learned how to 
download, install, and customize the HHS Reports ribbon.  Then, in part two, “Two 
Panes to Ease Your Pain,” you learned how to take advantage of the wasted space 
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on both sides of your document by using the navigation pane and the styles pane.  
Now that you’ve learned how to setup and use the powerful Word dashboard, 
you’re going to discover how templates and themes can standardize the formatting 
of all your reports.  By using the dashboard, templates, and themes together you’ll 
ensure every report you produce follows the HHS branding guidelines and meets 
accessibility standards. 

Scenario 1 - On Your Own 
In order to experience the effect templates can have on your documents, we’ll go 
through a couple of scenarios.  In our first scenario we’ll assume that we’re experts 
at writing documents and using styles to format them.  We’ll also assume that you 
are the only contributor to the creation of this document.   In another video we’ll 
focus on combining contributions from multiple team members.  Let’s begin by 
reopening the Texas Medicaid Drug Donation Study report.  This document has 
proper structure.  It has headings, bullet lists, and paragraph styles.  BUT it uses 
the MS default Normal Template instead of the HHS Reports Template.  So, right 
now, it’s fairly accessible, but without the HHS Reports Template loaded it doesn’t 
match the HHS branding guidelines.  The HHS branding guidelines not only help by 
ensuring consistency of documents across departments it also increases the 
accessibility of your document by using larger font sizes, weights,  color contrast, 
and a whole lot more. 

Download the HHSC Word Template 
If you don’t already have the HHS Word Template, you can download it from the 
HHS Extranet.  Before we download the template, we need to find out where Word 
is storing our templates. 

1. In Microsoft Word, select the “FILE” tab. 
2. Select “Options” from the File Menu. 
3. Select “Advanced” from the Word Options menu. 
4. Select the “File Locations…” button toward the bottom of the Advanced Word 

Options. 
5. From this list select the “User Templates” file type. 
6. Click the “Modify…” button. 
7. In the Modify Location window, right click on the address entry field at the 

top of the window and select “Copy”. 
8. Since we only want to find the templates location and not actually modify it, 

we’ll select the “Cancel” button. 
9. Now close the File Locations window by selecting the “Close” button. 
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10.Finally, cancel out of the Word Options window by clicking the “Cancel” 
button. 

Now we’re ready to download the HHS Word Template file. 

1. I’m going to use Internet Explorer so that I’m prompted for a file save 
location later. 

2. Now we need to open the HHS Connection page. It’s probably already set as 
your homepage. But in case it’s not your home page, go to 
hhsconnection.hhs.texas.gov. 

3. Select the Communications Services link or icon.  
4. Now under the Communications Services section select Templates. 
5. Scroll to the bottom of the Templates page. Just before the footer of the 

page three file links are available. 
a. HHS Word Template – Basic Instructions (MS Word) 
b. HHS Word Template – Full Instructions (MS Word) 
c. HHS Word Template – No Instructions (MS Word) 

6. Feel free to download the Full Instructions template and open it as you would 
any other Word document to read about writing your first document using 
this template. The full instuctions will present a lot of details on maximizing 
the use of templates. 

7. Since our document in this scenario is already complete, we’re going to 
download the “HHS Word Template - No Instructions” template. 

8. If you’re using Internet Explorer, you’ll be prompted, “What do you want to 
do with HHS-Template-for-Reports-No-Instructions.dotx?”  Choose the “Save 
as” option. 

9. Since we copied the templates location before we opened our browser, we 
can paste this location in the address field by right clicking in the address 
field and selecting “Paste” and then press Enter on the keyboard. 

10.You should see that you’re in a Templates directory. 
11.Now simply click the “Save” button, and the HHS Template will be ready to 

use.  

Attach a Template to a Document 
A template is a collection of styles and custom content suited to a specific kind of 
document. The HHS Reports template is customized for the task of creating a 
report. 

In this case, our report has already been created using the styles that come with 
Word. By attaching our custom template to the draft report, we can change the 
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appearance of every bit of text that is formatted with a style. Now it looks like any 
Word document. When we’re done, in a matter of a few seconds, it will look like the 
body of an HHS report.  That’s pretty amazing if I do say so myself. 

1. In the HHS Reports tab’s Structure group, click the Templates command. 
The Templates and Add-ins dialog box opens. Under Document template, you 
should see “Normal.” Normal is the default Microsoft template. Whenever 
you think you’ve created a document using no template, you have actually 
been using Normal.  

2. To find the new template, click the Attach… button and navigate to 
select the template you want to attach. In our case, it’s the HHS 
Template for Reports No Instructions. Once you’ve selected it, click the 
Open button. The entry under Document template has changed to HHS 
Template for Reports No Instructions. 

3. This step is very important: Below the Document Template field, select the 
Automatically update document style checkbox and then click the OK 
button.  

The headings and text in the document now look like an HHS Report. Save your 
document.  
 
One feature of an HHS Report is that the main headings are numbered. In the 
HHS Reports template, this numbering is built into the style we use for main 
headings, which is Heading 1. 

But something is wrong here. The executive summary is numbered “1” even though 
it isn’t part of the report itself. Let’s fix that. 

Look at the Styles panel. In addition to Heading 1, which is numbered, there is a 
new style that doesn’t exist in the Normal template called Heading 1 - No 
Numbering. Except that it isn’t numbered, it looks just like a Heading 1. Make sure 
the cursor is in the heading for the executive summary. Then click Heading 1 - No 
Numbering. The number is gone! 
 
Now look in the Navigation panel. “Introduction” used to be numbered 2, and now 
it’s 1. All the other main headings got renumbered, too. 

One of the hassles of creating a report is to get the numbering of sections to work. 
In our HHS Reports template, you don’t have to worry about that. The numbering is 
built into the heading style. 

Another vexing problem with reports is getting bullets in lists to behave. Bullets 
that should be the same can be just different enough to annoy the people who 
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matter. To make bullets consistent in all our reports, we assign them through a 
style: List Bullet. 

Find each bulleted list in the document. Select all the items in a list and 
then click the List Bullet style in the Styles pane. 

Notice that the bullet characters change. If you use the List Bullet style even when 
you’re working with the Normal template, this change will happen automatically 
when you attach the HHS Reports template to your document. 

Add Additional Pre-Formatted Contents to the 
Document with Ease 
Let’s turn our attention to adding additional content to this document to see how it 
gets affected by the presence of a new template. 

Add Document Properties 

1. In the File Tools Group, select the Properties command.  
2. In the Document Properties panel that appears, add or modify the Author, 

which should be the agency name.  In this case the author is the Department 
of State Health Services. 

3. The Title field is simply the title of the document.  It may or may not be the 
same as the name of your Word file.  The Title field is important to us 
because it’s used by Assistive Technology, like JAWS, to announce the name 
of the document to a user.  In this case the title of the document is “Texas 
Medicaid Drug Donation Study”.   Once the property information is entered, 
click the small “x” in the Document Panel to save the information and close 
it. 

Add Table of Contents (TOC) with Quick Parts 
Quick Parts is a feature in Word that makes it easy to add standard features to all 
your documents. Quick Parts are saved in a template. Our HHS Template includes 
quick parts that are standard components of our reports: a cover, a table of 
contents, and more. Let’s add a Table of Contents: 

1. In the Layout Group, click Quick Parts and scroll to the HHS TOC Quick 
Part, and then 

2. Right-click and select Insert at the Beginning of Document from the 
menu 
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CAUTION: Make sure you right-click, NOT just click, on the Quick Part. Right-
clicking gives you the choice of where to insert the Quick Part. Clicking inserts the 
Quick Part right where the cursor happens to be. 

Notice how the Table of Content was created based on the Heading 1 and Heading 
2 levels in the document. Notice also that a Page Break was also added for you to 
force the heading to the next page. 

Add A Cover with Quick Part 
Now, let’s add a cover also using a Quick Part. 

1. Click the Quick Part command again but this time right-click Cover 
Lege Report and select “Insert at Beginning of document”. 

2. Then, make the following edits: 
a. Title 
b. Legislative Reference 
c. Agency Name 
d. Date 

Add A Theme 
To make our documents more adaptable, we use a theme to set the HHS brand 
colors and fonts. In Microsoft Word, Excel, and PowerPoint, a theme is a tool for 
designating three features of your document: 

• The font to be used for headings. 
• The font to be used for the body of the document. 
• A color scheme—in our case, the HHS Brand colors. 

By using a theme, we make it possible for people who need different fonts or colors 
to adjust our documents to their needs. All they have to do is change the theme. 

This report is using the standard theme Microsoft offers: Office. Let’s change it to a 
theme built just for HHS reports: 

1. Click the Design tab and then click the Themes drop-down menu.  
2. Select the HHS Report theme from the drop-down menu  

Notice how both the fonts and the color scheme have changed: 
Before, we had Microsoft’s favorite heading font on a black 
background: 
After, we have the heading font for HHS Reports—that is, Rockwell—
on a deep blue background: 
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If you don’t see the HHS Reports Theme in your theme choices, call the help desk, 
and they can help you install it on your computer. 

Save as PDF File 
After the document has been structured correctly, the last step to take, if you 
need to convert it to a PDF file, is to save it as a PDF document. Since this 
document has only text, it should convert to a PDF format with little to no 
remediation for accessibility.  

1. Save your current document. 
2. Then, Click File > Save As from the menu. 
3. In the Save As dialog box that appears, select PDF from the Save As Type 

dialog box. 
4. Click the Options… button at the bottom of the dialog box. 
5. In the Options dialog box that appears, select the following options in the 

Include non-printing information section: 
a. Create bookmarks using: (checkbox) 

i. Headings (radio button) 
b. Document properties (checkbox) 
c. Document Structure tags for accessibility (checkbox) 

6. Click the OK button. 
The document will be saved in the same folder as the Word document with 
the same name but with the “pdf” extension. 

Conclusion 
In this video, you learned how to use templates and themes to standardize the 
formatting of all your reports.  By using the dashboard, templates, and themes 
together you’ll ensure every report you produce follows the HHS branding 
guidelines and is well-structured.  Always remember that a well-structured 
document is easier for everyone to read and will also be more accessible to people 
using assistive technology (AT) such as screen readers and other devices.  
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